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ABSTRACT

MikroTik operating system is designed for a network router. These functions include
IP Addressing, Firewall & Nat, Routing, Bandwidth Limiter, Point to Point Tunneling
Protocol, DNS server, DHCP server, Hotspot, and many other features. It is very useful
for our daily life. In this sector we will know about Cisco, MikroTik, Cabling, Linux
System etc. Network devices are connected to computers, peripherals, even LOT
devices. Switches, routers and wireless access points are the essential networking basic.
Through them device connected to network can communicate with one computer to
another computer and with other networks, like the internet. Now today a large number
of people all over the world usage internet technology with their dally life. So, the
networking is so much important fact right now. Now-a-days every single people,
business and e-commerce, every work station is fully depending on software-based
communication and internet technology. That is the reason it’s extremely valuable to
anchor the system. Computer system and peripheral are connected to form a network.
They provide various advantages, for Example-Instant messaging, parallel computing,
video conference, interaction with other users using dynamic web pages, sharing

information by using internet or web.
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CHAPTER 1
Introduction

1.1 Introduction:

A network device is connecting to computer, peripherals, even LOT devices. Routers,
switches and wireless access points are the essential networking basics. | choose this
internship because | wanted to benefit from the experience. Through them device

connected to network can communicate with one computer to another computer.

1.2 Motivation:

| am currently pursuing in the final semester of my Bachelor Degree program in CSE.
| choose my internship at Daffodil Online Limited (DOL) because | discovered that the
Daffodil Online limited has overcome every customer satisfaction & services because
of their excellent reputation. Daffodil Online Limited (DOL) is now a well-known and
reputed Internet Service Provider (ISP) in Bangladesh. | think that I can successfully

prove my experience by the help of Daffodil Online Limited.

1.3 Objectives:
Now in the modern world “Basic MIKRO TIK & LINUX” is a very generic term. The
internship program is making me as a compatible one in the job market. Temporary job
in software engineering is a stage to give better work encounter when an understudy is
still in school, to equivalent occupation aptitude with scholarly preparing, and to assist
understudy with preparing the change from school to work.

e Install Mikro Tik and perform network configuration.

e Install Linux for server administration and maintained hardware equipment.

Perform user and group administration.
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1.4 Introduction of Company:

Daffodil Online Ltd is a top-rated Internet Service Provider (ISP) in Bangladesh and
furthermore the most experienced and prominent organization in the ICT field where
they are essential business morals is Long Term Relationship with their clients. They
are exceptionally future. In the time of 2002 they are begun their excursion. Since the
earlier years, they expounded grateful of what they have picked up, and furthermore
more enthusiastic about their viewpoint for a similarly cheerful their exercises and
administration office following to the client’s proposal and thinking about need of time.
[2

1.5 Layout of the Report:

In this report | shown the introduction, motivation, objective, introduction of company,
introduction about my internship organization, and also about the company, company
product for marketing and organization structure of the company.

After that | show my internship dally task with activities events and project task and
activities.

At last | described Conclusion & Discussion, Future Career & Scope, and also discussed
Future Scopes of the platform MikroTik and Linux.
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CHAPTER 2

Organization

2.1 Introduction:

The internship enterprise where I have taken my Training is Daffodil Online Ltd.
Daftodil Online Ltd. (DOL) is proud to be one of the promoters and oldest ISP/ASPs
in Bangladesh and providing one stop integrated ICT services and solution since July
2002. During. the past years, they extended their operation and service portfolio

according to the customer’s recommendation and considering demands of time.

2.2 Product for Marketing:
Daffodil Online Ltd. prides itself as one of the main across the nation Internet Service
Provider (ISP) in Bangladesh. They are the most experienced and most seasoned
organization in the ICT field where they are fundamental business morals is Long Term
Relationship with their clients. As they take a gander at the development throughout
the decade since our origin, they are to a great degree glad for what we have
accomplished and considerably more amped up for our viewpoint for a similarly
encouraging future. Daffodil Online Ltd likewise gives distinctive IT Services and
Professional Training administrations. These are given underneath.
The Daffodil Online Ltd provides us particular IT Based Professional Training services.
These are:

e ISP support.

e IT Security protection.

e Web Hosting & Domain Registration.

e Corporate level Internet Solution.

e |IT based Professional Courses & Training.

e Open Source application solution.

e Web site Development.
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2.3 Organizational Structure of Daffodil Online Limited:

Chairman
Managing Director

General Manager

CEO
Manager
Deputy Manager
Sr. Assistance Manager
Assistance Manager
Senior Officer
Officer

Officer Staft

Figure 2.3.1.0: Organization of Daffodil Online Limited
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CHAPTER 3
Internship Roles & Responsibilities
3.1 Daily Task and Activities:

» Month - I: In the first month of my internship at daffodil online limited I have
learned and performed the following tasks:
v" About IP address.
Introduction of MikroTik.
PC based Installation of MikroTik Router OS using VMware.
Configure Mikro-Tik Router with Commands.
How to configure ISP link.

AN N N NN

How to configure your LAN Network.

» Month - 2: In this month I have learned and performed the following tasks:
v Bandwidth Control in different ways.
v" Bridge mode configure.

v" Firewall and NAT Configuration.
v Network Security.

» Month — 3: In this month of I have learned and performed the following tasks:
Introduction of LINUX.

Installation of Linux CentOS 6.4.

Managing User Accounts and passwords.

Basic Linux Commands.

File and Directory Making and Control.

RN NI NEEN

Work Effectively on the Unix Command Line and Run level concept.

» Month — 4: In this month of my internship at daffodil online limited I have
learned and performed the following tasks:
v" File and Directory Permissions.
v" User and Group Add and Modification.
v" Ownership, Group and User Permission.
v ACL Permission Configuration.
v

Linux System Administration.

© Daffodil International University



3.2 Events and Activities:

Preparing is critical for temporary position is the main stage, when an understudy faces
some issue amid entry level position, at that point it is obligatory to give preparing to
address the issue. Issue has been identified& preparing can be tackling it. Preparing can
be depicted aptitudes, ideas, enhanced execution in temporary position condition. In

this internship on daffodil online limited I have learned and performed the following

tasks:
v About IP address for all class of IP with Subnet.
v Mikro-Tik Router and Configuration.
v" Learning & understanding About Network Components.
v' Install and Configuration in Linux, step by step full describe with figure.
v" Linux System Administration.

3.3 Project Task and Activities:

3.3.1 About IP address:

An Internet Protocol address (IP address) is a numerical name pointed to every gadget
associated with a PC organizes that uses the Internet Protocol for correspondence. An
IP address serves two main capacities: host or system interface ID and area tending to.
Web Protocol form 4 (IPv4) characterizes an IP address as a 32-bit number. Be that as
it may, in light of the development of the Internet and the exhaustion of accessible IPv4
addresses, another adaptation of IP (IPv6), utilizing 128 bits for the IP address, was
created in 1995, and institutionalized as RFC 2460 out of 1998. IPv6 organization has
been continuous since the mid-2000s. IP addresses are normally composed and shown
in intelligible documentations, for example, 172.16.254.1 in IPv4, and

2001:db8:0:1234:0:567:8:1 in IPv6.

© Daffodil International University 6



3.3.2 Introduction of MikroTik:
MikroTik is a network-based equipment manufacturing company. MikroTik was
founded by Latvia in 1996 to develop ISP System with Router & Wireless Devices. 4!
3.3.3 PC based Installation of MikroTik Router OS using VMware:
Requirement Items:

e VVMware Workstation Application.

e Mikro-Tik Router OS ISO image file.

e Winbox.

Now | show the Install Guideline Step by Step:
Step 1: At first install VMware application and open it, then click on File>New Virtual

Machine>Typical>Next.

O n e

mikrotik-6.22  VMware winbox
Workstati...

&) B23 - VMware Workstation

File Edit View VM Tabs Help - L |0 = New:Virtual Machine Wizard ><
‘2 Ne Virtual Machine... Ctri+N
75 NewWindow Welcome to the New Virtual
Open.. Ctrl+0 Machine Wizard
Scan for Virtual Machines.
Close Tab Ctrl+W Ly tual ine - What type of configuration do you want?
[ Connect to Server.. Ctri+L  ftual machine settings 1 &
&3] Virtualize a Physical Machine. e N tion 143 vistual

&1 Map Virtual Disks... Iy 512 MB
Exit bors 1 c s e with advanced
— optio such as a SCSI controller type,
&2 Hard Disk (IDE 8G8 virtual disk type and compatibility veith
‘ older VMware products.
CD/DVD (IDE Using file EAMik.
8 Network Adapter Custom (VMnet0)
& Network Adapter 2 Custom (VMnet8)
@) Sound Card Auto detect X
@ Display Auto detect |

Help Cancel

Figure 3.3.3.1: VMware welcome screen

Step 2: Now Select on the Installer disk image file(iso) and choose the iso image file
and then click on Next. After that create a virtual machine name and also choose a
location where the machine is Install, then click Next. Now configure the Hardware

requirement how we have need.

© Daffodil International University 7



New Virtual Machine Wizard x MNew Virtual Machine Wizard =
Guest Operating System Installation Hame the Virtual Machine
A virtual machine is like a physical computer; it needs an operating What name would you like to use for this virtual machine?
system. How will you install the guest operating system?
I from:
st from Virtual machine name:
(O Installer disc: {TEHUEI
~ CD Drive (H:) Location:
& C:\Users\Mahmud\Documents\virtual Machines\Testo2 Browse...
23
The default location can be changed at Edit > Preferences.
@ Instalier disc image file (iso):
E:\MikroTik\MikroTik\mikrotik-6.22.is0 .
.3\ Could not detect which operating system is in this disc image.
You will need to specify which operating system will be installed.
(O 1 will install the operating system later.
The virtual machine will be created with a blank hard disk.
Help < Back Next > Cancel < Back cancel

Figure 3.3.3.2: VMware Configuration for MikroTik OS

Step 3: Now click on the “Power on the virtual machine” and then show a welcome

screen where click “a” for select all and then press “I” to install. Then press “n” to do

not keep configuration and “y” to continue. After install complete show a login screen,

where press MikroTik Login: admin and password: admin then enter.

Melcore to MikroTik Router Software inst

admin

Figure 3.3.3.3: MikroTik OS Installation
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3.3.4 MikroTik Router Configuration:

Internet

Public Networl:
10.5.8.0/24 =
Gateway
10.5.8.1

Interface: Public
IP Address: 10.5.8.104

Interface: Local

Loca) Netwrek 128kbps  IP Address: 192.168.0.254

192.168.0.0/24

g Laptop

Server

192.168.0.1 —_— 192.168.0.3
Workstation
192.168.0.2

Figure 3.3.4.1: Network Topology of MikroTik

At first download Winbox and router os ISO image file, after that install router os in
vmware and run winbox, now click on the Mac address type “admin” in login window

and do not need to give user Password. [

@ admin@00:0C:29:96:E4:D7 (MikroTik) - WinBox v6.22 on x86 (x86) — O X
Session Settings Dashboard
[][c] [ SafeMode | Session:[00:0C2996E4D7 B
| 4 QuickSet

i CAPsMAN
8 Interfaces
5 Wireless Terminal ]
%2 Bridge i
=3 PPP
o2 Mesh MM M KKK TITITIITIIT KKK
o MmaM MmaM KKK TITITTIITIIT KKK
%lp 1y M MM MMM III KKK KKK RRRRRR 000000 TTL III KKK KKK =1
%Q_J|PV6 PH}M}HHHHIIIKKKIG( RRR RRR 000 000 TIT III KKKKK
MM MMM III KKK KKK RRRRRR 000 000 TIT III KKK KKK
<> MPLS M e MM III KKK KKK RRR RRR 000000 TIT III KKK KKK
#2 Routing I ) ) i .
: MikroTik RouterOS 6.22 (c) 1999-2014 http://wew.mikrotik.com/
2 System P
& Queues
= ROUTER HAS NO SOFTWARE KEY
[ Files
|| Log You have 23h32m to configure the router to be remotely accessible,
Radi and to enter the key by pasting it in a Telnet window or in Winbox.
. Radius Turn off the device to stop the timer.
x Tools I* |See www.mikrotik.com/key for more details.
L!New Terminal Current installation "software ID": 3RBP-JIKQ
ISDN Channels |Please press "Enter” to continue!
ping 192.168.50.1 L
E5KVM [admin@MikroTik] > ping 192.168.5f Rd
| 2 Make Supoutrif] T
& Manual ¢ [»]
@ New WinBox 3items

Figure 3.3.4.2: Winbox Dashboard
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3.3.5 Static-1P Configuration in MikroTik Router:

At first Click on “Interface” to show and define our port such as LAN, MAN, WAN.

Session Settings Dashboard

© admin@00:0C:29:96:64:D7 (MikroTik) - WinBox v6.22 on x86 (x86) — a X

54 Bridge

Now, click on “IP>Address>Add IP on Address and Network>Apply OK”.

\3 @ Jgak Mode Session.\w]
A5 Quick Set
1 CAPsMAN
{ma Interfaces
3 Wireless

/@ New Terminal <

@ New WinBox

Interface \Enae olPTu-mel\ IP Tunnel | GRE Tunnel VLAN | VRRP | Bonding | LTE

[+][=] [~][x] [a]

78 Interface <etherl>
General | Ethemet| Status | Traffic|
Name: Cancel
Type: |Ethemet ] Apply
MTU: [1500 | Disable
L2MTU: | | Comment
r Max L2 MTU: [ ] Torch
MAC Address: [00:0C:29.96.E4.CD | Cable Test
2items (1 sele — =
ARP: [enabled =] Blink
ResetMAC Addre:

Figure 3.3.5.1: Interface

: OK
Network: |192.168.50.0 - Cancel

Interface: [ethert WAN  |[% | Apply
Disable
Copy

‘enabled

2 items (1 selected)

Figure 3.3.5.2: IP Addressing

Next, click “IP>DNS>Add Server IP address>Apply OK”.

DNS Settings =] E3

Servers: [203.190.10.252 s [ ok |

[203.190.10.253 |& | Cancel

Dynamic Servers: |

] Allow Ri te Req
Max UDP Packet Size: [4096

Cache Size: Ki

Cache Used: I8 i

Figure 3.3.5.3: DNS Server

© Daffodil International University
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After that click on “IP>Firewall>Add+>Action>Select=masquerade>Apply Ok”.

[E@ | SafeMode | Session:[00:0C:29.96.E4:D7

4 Quick Set New NAT Rule X
1 CAPsMAN Advanced} Extra Action |Staﬁsﬁcs‘ ‘ | |
@ Interfaces
= Wireless Action: |accept " ¥ ‘ | Cancel |
: accept A

25 Bridge add dstto address list I Pply I
=g PPP add src to address list Disable
°12 Mesh pig euti | |
. ‘o U S il jump | Comment |
1P " | Filter Rules lo Cop pols|
g IPVB P g y
£ MPLS v |H=] [ s [ Remove ]| Jlat

/ : passthroug S
#Routing 1 |-F I s redirect |_ResetCounters | & i e
i System » :t‘r‘;: | ResetAll Counters |
& Queues src-nat
Files ‘

Figure 3.3.5.4: Firewall

Now click “IP>Routs>Add+ New Route=Dst. Address + Gateway>Apply OK”.

A5 Quick Set
i CAPsMAN
= Interfaces
i Wireless
#5 Bridge General ’Amibutes ]
o.f hPAF;:h Dst Address:
@ P > Gateway: |192.168.50.1 [=] ]
gl IPv6 P
£ MPLS | Check Gateway: | Ly
#2 Routing N Type: |unicast
53 System r
& Queues Distance: I
[ Files Scope: |30
[l Log Target Scope: |10
S Radius )

> Routing Mark: |
& Tools P
[@m New Terminal Pref. Source: |

ISDN Channels
= WNIRA

Figure 3.3.5.5: IP Routing
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After process are complete then check the instruction by “New Terminal>Terminal=
ping (IP)>OK”.

| [ safeMode | Session:[4C:5E:0C:28:84:83 B
A5 Quick Set
i CAPsMAN
i Interfaces
I Wireless Terminal (%]
24 Bridge ININGED, Boomese Mo @) B By
3 PPP ?ON P N )
= 2 AN E <IAdE &)L B %
== Switch VONVLILNALL A\ I_I_IN\ (c)2013
o8 Mesh MikroTik RouterOS 6.41.1 (c) 1999-2018 http://www.mikrotik.com
g P P [2] Gives the list of available commands [
% MPLS > |command [2] Gives help on the command and list of arguments
RRou’nng ¥ [Tab] Completes the command/word. If the input is ambiguous,
{5 System ¥ a second [Tab] gives possible options
QQueues / Move up to base level
Files L Move up one level
Lo /command Use command at the base level
4] 9( [admin@MikroTik] > ping 192.168.50.1
$ Radius SEQ HOST SIZE TTL TIME STATUS
XTOOIS Iy 0 192.168.50.1 56 €4 Oms
- 1 192.168.50.1 56 €4 Oms
{@ New Terminal 2 192.168.50.1 56 €4 Oms
!LCD 3 192.168.50.1 56 €4 Oms
4 192.168.50.1 56 €4 Oms
£ MetaROUTER 5 192.169.50.1 56 64 Oms L
& Partiti i 1%
#% Partition TR—1

Figure 3.3.5.6: IP Ping

Final Step, now connect pc with static IP click on “PC Setting>Network>Change
adapter setting>Ethernet>Properties>IPv4=Use your static IP address, gateway,

subnet mask and DNS server>Apply OK”. [6]

™| Bluetooth Network Ethernet ™| VirtualBox Host-Only
r Connection Network 5 Network
X Not connected g Killer E2500 Gigabit Ethern... Disabled
e L VMware Network Adapter ™ | VMware Network Adapter Wi-Fi
e VMnet1 VMnet8 Not connected
& Disabled 4‘“—*‘4—“—# Killer Wireless-n/a/ac 1535 ..
Cohacant Cins
W Ethernet Properties X

Networking ' Sharing

& .
| Internet Protocol Version 4 (TCP/IPv4) Properties X

| General

-

You can get IP settings assigned automatically if your network
supports this capability. Otherwise, you need to ask your network

§  administrator for the appropriate IP settings.

[}

§ (O Obtain an IP address automatically

8 @Use the following TP address:

[c}

-
0 subnetmask: 255 .255.255. 0
e

Obtain DNS server address automatically

(@ Use the following DNS server addresses

Preferred DNS server: 203.190 . 10 .252
Alternate DNS server: 8 .8 .8 .8
[[Jvalidate settings upon exit (B J

Figure 3.3.5.7: TCP/IPv4 Configuration
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3.3.6 At first click on “IP>DHCP Server>DHCP Setup= select needed server
interface>Next>DHCP Address Space= example (172.160.20.0/24)>Next>Gateway
DHCP Network= example (172.160.20.1)>Next>Address to Give Out>Next>DNS

Server>Next>Lease Time”.

6 (DHCP) Dynamic Routing Configuration with MikroTik:

©8 Mesh =
wP oW owceserver =
< MPLS P DHCP |Nemorks‘ Leases‘ Options  Option Sets | Alens‘
- :°“l"“9 ; _J[: (][] [¥] [[orice contg | DHEP Setp |
: oys il [Name / [Interface |Relay [Lease Time |AddressP.. AddA. 54
ueues

[ Files

|| Log
M Radius DHCP Server Interface: |wian7? N £
& Tools [} etherl-WAN "
@ New Terminal [ ether?
= LCD ether3

| etherd-LAN
#4 MetaROUTER |ethers

& Paiti | ether6
¢ Partition \ether7

| 4 Make Supoutrif |ether

M | |etherd

9 Ml [0items \ether1o
@ New WinBox skl

B Ext P

DHCP Setup

[=] E3 [ DHCP Setup
Select network for DHCP addresses Select gateway for given network

DHCP Address Space: (B

Select pool of ip addresses given out by DHCP server

Addresses to Give Out ( 2.1

[=] E3 § DHCP Setup

DHCP Setup

DNS Servers: [203 190.10.252 ¢ Lease Time: {24:00:00 |

1203.190.10.253

ek LS ]| e 1

| Back || Ne% || Cancel |

Figure 3.3.6.1: Dynamic (DHCP) Configuration
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Now Restart winbox and reconnect ethernet port IPv4 into automatic from pc then click

from winbox “IP>ARP= where show ARP list”. [

DEEEE

|IP Address  / [MAC Address Interface v
DC 9172160202 4CCCOHADF889A etherd-LAN
D 917216020254 4C.CC.6ADF889A etherd-LAN
DC ©19216850.1 D4CAGD:81:6D56 etherl-WAN

3items
) i S
@ Ethernet Status X ;I
Network Connection Details X
Network Connection Details:
Property Value
Connection-specific DNS S...
Description Killer E2500 Gigabit Ethernet Controller
Physical Address 4C-CC-6A-DF-88-9A
DHCP Enabled Yes
IPv4 Address 172.160.20.254
IPv4 Subnet Mask 255.255.255.0
Lease Obwirﬁd Tuesday. October 9. 2018 45753 PM
Lease Expires Wednesday. October 10, 2018 4:57:54 PM
IPv4 Default Gateway 172.160.20.1
IPv4 DHCP Server 172.160.20.1
IPv4 DNS Servers 203.190.10.252
203.190.10.253
IPv4 WINS Server
NetBIOS over Tcpip Enabl.. Yes
Link-local IPv6 Address fe80::5908:a9%eb:8edb:8f1%2
IPv6 Default Gateway
IPv6 DNS Server

Figure 3.3.6.2: ARP for Dynamic (DHCP) Configuration
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3.3.7 Bridge Configuration with MikroTik:

“Bridge>click + Add>Bridge n=1,2,3.... > +name fill up>Apply Ok”

Select Ports:

v
v
v
v
v

“|P>DHCP server >DHCP setup>Next>Apply Ok”.

>

ether2

ether3 LAN
ether6 MAN
ether9

wlanl

Step 1:

[=o][ox] [ e Moce
| /& Quick Set
3 CAPsMAN
= interfaces
L Wireless

1

i

Session: D4CAD:86.C0.00)

i -

[#][=] [“][] (] [] [ sotrms
Name < Type

R £lodgel Bdge

Figure 3.3.7.1: Create Bridge name

b Packet p/s)  |FP Tx
0

Bidge _Povtslm-, NAT  Hosts Generdl | Satus o
[#[=] [l [=] [x] todoce: SR | [ Concel
0 'K.'.L."z /‘:\;‘:1 ‘Mhéblm‘ Brdge: [saddam [ Aoply
Priorky: |80 hex Disable
Path Cost: [10 Comment
Horizon: h o Copy
e [ase  [] | L0
Point To Pont: |auto 53
Extemal FDB: [auto =]
[ Auto lsolate
Ttem .
 enabled [mactive

Figure 3.3.7.2: WAN configure of Bridge port

© Daffodil International University

15



» Step 3:

A& Quick Set [x]
3 CAPSMAN Bidge Pots |Fiters| NAT Hosts
r |
1 Interfaces L JE |a| |7 |
1 Wireless inteface + |Bridge Priorty ... |Path Cost | Horizon | Role [Root Pat... | I+
S Bidge 1 ttethers saddam 80 disabled port
= | Adethert saddam 80 10 disabled port
=2 PPP | tetherd saddam 80 10 disabled port
== Switch I wlan! bridge1 80 10 disabled port
°1g Mesh DHCP Server EE|
&8P el DHCP | Networks  Leases Options Option Sets = Aletts
& MPLS r +/ ¥/ [ DHCP Config || DHCP Setup
g s I = |
22 Routing | Name Interface Relay[— o | [AddAR v
£ System P dhepl bridge DHCP Setup no I
dhep2 unknown no
Qu
? s | dhep3 unknown Setup has completed successfully no
(5] Files dhcpd saddam no
L) Leg
M Radius
S Tools r |
@ New Teminal
® Lco ‘
¥4 MetaROUTER
#5 Parition |
Maki i
| 4 Make Supout P
@ Manual

Figure 3.3.7.3: DHCP Setup configure

3.3.8 Site Blocking Configuration:

Site Blocking Rules: “Such as YouTube and Facebook ”

Regexp>
A, + (youtube.com).*$,
N, + (facebook.com).*$

This is the rule for block site, we need to apply these rules.

“IP>IP address>IP assign 172.10.0/24>Firewall>New firewall 7 Protocol>YouTube

name assign>Apply Ok>New firewall rule>General>source address IP assign

172.10.0/24>Apply Ok™. [

» Step 1.

A& Quick Set

1 CAPSMAN + ally
[ intedfaces
I Wieless
#5 Brdge
=3 PPP

== Switch

Address Network
17250.10.1/24
192168.50.24/24

Interface

172.50.10.0 saddam
192168500 ether2

EE)

©13 Mesh
P
WPLS
¥ Routing T
& System Neme e
@ Gueves of o
(5] Fles
Log

2 Radus
X Tools
8 New Teminal
= 1co
#4 MetaROUTER
#5 Parition

2 Make Supout #

Fter Rules NAT Mangle Raw Service Pots Connections Address Lists Layer7 Protocols

New Firewall L7 Protocol

Name: | TSN

(=3

@ Manual 2tems

Figure 3.3.8.1:

© Daffodil International University
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» Step 2:

;7“ O‘j | Safe Mode J Session: |DA.C

[#[[=] [~][] [g] [7]

A4 Quick Set

1 CAPsMAN

¥ Interfaces

1 Wireless

3& Bridge

=2 PPP

== Switch

©18 Mesh

55 1P I
<’ MPLS f
42 Routing {3
5 System P
& Queues

[ Files

] tog

M Radius

K Tools ¥
| New Teminal
=i cD

¥4 MetaROUTER
#5 Partition

| = Make Supout rif
@ Manual

@ New WinBox

B 5t

» Step 3:

A& Quick Set
I CAPsMAN
8 Interfaces
3 Wireless

| Log

. Radius

A Tools I
(i) New Terminal
L_le)

=4 MetaROUTER
@5 Partition

| & Make Supout rif
& Manual

A8 M WinDaw

New Firewall Rule

General ‘Advanoed Extra  Action Statistics

© Daffodil International University

|Address / [Network [Interfac Chan:
17250.10.1/24 17250100 saddan| :
%9192.168.50.24/24 192168500  ether2 Src. Address: [
Dst. Address:
Protocol:
Src. Port @IZI
Fiter Rules | NAT Mangle Raw Service Potts Conned pstPot [ |~ Remove
1] [¥] [0 Reset Counters || syt [ v | [ RestComten |fi_ 3]
-~ [Chain [sre. Address p2p: | | v Reset All Counters Jﬁ"?‘,{:;
0 forward ]
1 In. Interface: | |~ .
3 17250.10.0 Out. Interface: v B
3 = a8 17
5 ard 7250100 . ]
6 forward  172.50.10.0/24 netaceta: [~ kis
Out. Interface List: | |~
Packet Mark: | |
Connection Mark: ‘7 [
| Routing Mark: [_4" A |
¢! ; S EY
7 ems Routing Table: J 3 |
Connection Type: ‘ | >
Connection State: ‘ 1 %
Connection NAT State: | | ¥
Figure 3.3.8.2: IP source configure, drop and forward
+ [Fro ]
| | ’ \'Ne'lwork | Interface i
10, 17250100  saddam
£7192.168.50.24/24 192168500  ether2
Firewall [=] E3
Fiter Rules NAT Mangle Raw Service Pots Connections Address Lists Layer7 Protocols ‘
=] [=] [¥] [Fnd ]
/ |Regexp [ 4
"~ #facebook.com).’s |
1item
Figure 3.3.8.3: Final Result of Site Block



3.4.1 Installation of Linux CentOS 6.4:

In this session, I will show that how to install CentOS 6.4 using the 1SO image file in
USB device. [/l

3.4.2 CentOS 6.4 Installation Guide:

1. First we need to download the CentOS 6.4 DVD ISO image file and then create a
bootable USB stick using LiveUSB Creator called Rufus.

2. After that, boot our pc and select the bootable USB, press any key to access the Grub

boot menu, then select USB disk and click Enter to Install.

Welcome to Cent0S 6.4!

A=ly 5 )
Rescue installed system
Boot from local drive

Memory test

Press [Tabl to edit options

Automatic boot in 49 seconds...

CentOS 6

Community ENTerprise Operating System

Figure 3.4.2.1: CentOS 6 installation Welcome Screen

3. Click on Next to proceed, then choose the installation language package whatever

you wish to use, and click on Next.

© Daffodil International University 18



CentOS6*

Community ENTerprise Operating System

%

What language would you like to use during the
installation process?

Bulgarian (Gbarapcku)
Catalan (Catala)
Chinese(Simplified) (#737 (%) )
Chinese(Traditional) (3¢ (ER) )
Croatian (Hrvatski)

Czech (Cestina)

Danish (Dansk)

Dutch (Nederlands)

Estonian (eesti keel)
Finnish (suomi)
French (Frangais)
German (Deutsch)
Greek (EAANwKa)
Gujarati (2pvicll)
Hebrew (n12)
Hindi (=)

4uBack

Figure 3.4.2.2: Language pack for Setup

4. Select the appropriate keyboard layout you wish to use such as “U.S. English” and

click on Next and select the storage devices and click Next to install process.

%\ Select the appropriate keyboard for
the system

Portuguese ~
Romanian

Russian

Serbian

Serbian (latin)

Slovak (qwerty)
Slovenian

Spanish

Swedish

Swiss French

Swiss French (latin1)
Swiss German

Swiss German (latinl)

Turkish

U.S. intemational
Ukrainian
United Kingdom

What type of devices will your installation involve?

al types of storage devices. If you're not sure which option s right for you,
this is probably it

lized Storage Devices
 upgrades to enterprise devices such as Storage Area Netwarks (SANs). This option wil allow
dd FCOE / SCSI / 2FCP disks and to filter out devices the i should ignore.

4pBack | |

Figure 3.4.2.3: Keyboard Type and Storage Selection

5. In storage device warning, select the option to clear data on the storage disk by

selecting Yes, discard any data and click Next. Now set the Hostname and click Next.

Storage Device Warning

4«; The storage device below may contain data.

VMware, VMware Virtual S
— 204800.0MB  pci-0000:00:10.0-5¢si-0:0:0:0

We could not detect partitions o filesystems on this device.
This could be because the device is blank, unpartitioned,
orvirtual. If not, there may be data on the device that can
not be recovered if you use it in this installation. We can
remove the device from this installation to protect the data.
Are you sure this device does not contain valuable data?

 Apply my choice to all devices with undetected partitions or filesystems

a || Mo, keepany data

4uBack

Please name this computer. The
@ hostname identifies the computer on a
network.

Hostname: |

Configure Network

4 Back

© Daffodil International University
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6. Set the Time zone for your location and click Next to proceed, then set the root user

password and confirm it and click on Next.

Please select the nearest city in your time zone: The root account is used for administering
g the system. Enter a password for the root
user.
Root Password:
Confirm:
R
Selected city: Dhaka, Asia
[N
¥ System clock uses UTC
uBack 4sBack

Figure 3.4.2.4: Time Zone Selection

7. Now, you need to choose which type of installation you want to install. Now flow

the instruction step by step for partition all drive.
Step 1:

Which type of installation would you fike?
Please Select A Device
Size  Md Create Storage
Device
(M8) | RA Create Partition
> Hard Drives
< sda
Free 204797 Create Software RAID Information
Shrink Current System RAID Partition
Shrinks existing partitions to create free space for the default layout
Use Free Space
Retains yot nd partitions and uses only the unpartitioned space on the selected device Create LVM Information
(s). assu nough free space available
stom layout on the selected device(s) using our partitioning tool
LVM Physical Volume
Cancel
1S
Create Reset
4aBack 4 Back ) Next

© Daffodil International University
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Step 2:

Device

v Hard Drives
v sda

Free

Mount Point:

File System Type: ‘

4
Allowable Drives:
Size (MB): 1
Additional Size Options
( ze

O Fill all space up to (MB):

O Fill to maximum allowable size
[ Force to be a primary partition
[] Encrypt

Cancel Dege:

| ﬁgéck

| = Next |

Figure 3.4.2.5: Partition layout Selection

Please Select A Device DL A D -
Add Partition
[Mount Point:
size Create Storage
Device & Device 3
(MB) | RATCreate Partition File System Type: 3
v Hard Drives Standard Partition < Hard Drives
v sda v sda
sda1 200 /bd Create Software RAID Information sdal M
Free 204599 RAID Partition fras Allowable Drives:
Create LVM Information size (MB). :
Additional Size Options.
Fixed size
Fill all space up to (MB):
Force to be a primary partition
Cancel
7] Encrypt
Reset
Create Reset pose 5
[
4uBack ) Next 4uBack ) Next

Step 3:

© Daffodil International University
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Please Select A Device
[volume Group Name: Vg
Device (s’:}:) SisRiSt oy E Device [physical Extent: 4MB s
Create Partition
~ Hard Drives Standard Partition ~ Hard Drives vl 5022 204596.00 MB
< sda v sda
sdal 200 /b Create Software RAID Information sda1  |Physical olumes to Use
sda2 204599 RAID Partition St

Used Space: 0.00MB (0.0 %]
Reserved Space:
Free Space: 204596.00 M8 (100.0 %)

Create LvM Information o it

© LM Volume Group Logical Volumes

Logical Volume Name Mount Point  Size (MB)
add
LVM Physical Volume
ysical Volume s
elete
cancel | [ create | 2
IS
Create Reset Reset
Cancel
4aBack ) Next 4 Back ) Next

Step 4:

LVM Volume Group VG (204596 MB) LVM Volume Group VG (204596 MB)

[ree %
e ae N ‘ Edit LVM Volume Group: VG
Volume Group Name: [ve
Create Storage .
Device Device physical Extent: aMB 2
~ VM Volume G ) sda2  204596.00 MB

~ LVM Volume Groups

Make Logical Volume [F—

Create Software RAID Information Physical Volu

Free 204 Free [P 5
v Hard Drives BAID Paitition S Haid Drives [Mount Point: ) ]
- sdad v sdad Used space: |Eile System Type: | swap =
sdal sdal  |Reserved Spacq
jical Vol : 10
sda2 2049 Create LVM Information sdaz  [Fimepace [LOGHBUVIIE HRDE RS )
Total Space: |gi76 (mp): 2048
Logical Volu
St lens 1 Ge O Encrypt (Max size is 204596 MB)
@® [LVM Logical Volume| VG < Logical Volu — -
Logical Volume J [(cancet [ ck || ad
) LVM Physical Volume " Edit
==—-. | Detete
cancel || create | e
Create Edit Delete || Reset - Reset
|- Cancel oK =
[ | o nex |

| gmBack 1 ) Next ‘ |

Step 5:

Please Select A Device Please Select A Device
Size | Mount Point/
Device o et ] Type Format Device Format Warnings
'~ LVM Volume Groups '~ LVM Volume Groups “The following pre-existing devices have been selected to be
v VG 204596 < VG formatted, destroying all data.
LogVolo1 100000 / extd v LogVolol Jdev/sda partition table (MSDOS)
LogVol00 2048 swap v LogVol00
LogVol02 102548 /home extq v LogVolo2
v Hard Drives v Hard Drives
v sda v sda
sdal 200 /boot extd v sdal
sda2 204599 VG physical volume (LVM) v sda2
3
cancel | [~ Format |
S
[ greate Reset create Reset
aBack ‘ o Next | daBack L?Eext |

13. Then Click Write changes to disk and then click Next to proceed and now, select
the installer to install the boot loader, then click Next to start installation process of

files.
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¥ Install boot loader on /dev/sda. | Change device
Please Select A Device e
C) Use a boot loader password
Device 328 MountPoint oo coap Boot loader operating system list
(M8) RAIDNolume
Default Label | Device ‘add
®  Cent0S /devimapperVG-LogVol0l Edit
Writing storage configuration to disk Delete
A\ The partitioning options you have selected Installation Progress
&5 will now be written to disk. Any data on e - >
deleted or reformatted partitions will be lost. Retrieving installation information for Cent0S.
)
Go back Write d\apes to disk
Create Reset
4aBack B Next 4aBack B Ne@

15. For GUI Select Desktop and then click Next to proceed and wait for until complete

the installation.

The default installation of Cent0S is a minimum install. You can optionally select a
different set of software now.

O Minimal Desktop
Minimal

Basic Server =

Database Server CE n

Web Server Community ENTerprise Operating System

© Virtual Host =

Cafhuaca Daualanmant itladsctatian

%

Please select any additional repositories that you want to use for software installation. pieted: 621 of 1089

¥ Centos
Installing farsight2-0.0.16-1.1.e16.x86_64 (484 K8)
Libraries for videoconferencing

4 Add additional software repositories 5 Modify repository

You can further customize the software selection now, or after install via the software
management application.

@® Customize later Customize now

L3
qasack | | wpnext ‘

17. After rebooting and starting all services, you will land at the Welcome screen,
click on Forward to continue. Now, agree to the CentOS License Agreement and

click on Forward.

Welcome

Thoce e a fow more seps to take ber

ystom i ready touse,

Please clck the "Forward® uttan n the ower

CentOS6 &

& 30 2gree to the icense Agmemen:
Mo 10 ot apree

ot

b R

Figure 3.4.2.6: CentOS License Agreement

© Daffodil International University 23



18. Now create an additional user, enter the username, full name and set for it a
password and confirm the password and click Forward to proceed. Next, set the Date
and Time for your system. It is recommending to synchronize data and time over

network. Once you are done, click Forward.

Date and Time

Create User

Figure 3.4.2.7: CentOS User Create, Date and time setting

19. Finally, log into new CentOS 6.4 system as shown. Use your Username and
password to log in. (€

Figure 3.4.2.8: CentOS User Login and Welcome Screen

3.4.3 Introduction to Linux Kernel and Shell:

Kernel:

The kernel is a computer program that is use for the core of a computer’s operating
system, with complete control over everything in the system. The manages resources

of the Linux system is—

» Process management.

= Memory management.
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= |/O management.
= File management.

= Device management etc.

Shell:

A shell is special user program which based on interface to user to use operating system
services. Shell program accept human readable commands from user and convert them
into something which kernel can understand. It is a command language interpreter that
execute commands read from input devices such as from files or keyboards. The shell

started when the user log in or start the terminal program. [

Shell is broadly classified into two categories —
= Command Line Shell

= Graphical shell

o overide@Atul-HP: ~
overide@Atul-HP

€ |
overide@Atul-HP I

P Yo

gfg

¢ > AHome Desktop gfg docs

© Recent =
e é

A Home —

docs knearest.py longest_even_
B Desktop length_sum.py
B Documents
¥ Downloads é e
71 Music max_loot.py min_offerings.py pattern.py

Pictures

M Pictu a a
W Videos quick_hull.py sumtree.py
@ Trash

Figure 3.4.3.1: Command Line Shell and Graphic Shell
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3.4.4 How to break Root password in Linux OS:

In VMware we have to do at first

press ctrl alt delete or restart the system >space press > e >kernel /vmlinuz
select>e>space 1>enter >b>passwd>new password input>retype password>

init 6>login root user with new password then apply.

» Step 1:

GNU GRUB wversion 8.97 (636K lower ~/ 3143552K upper memory)

Cent0S (2.6.32-358.el6.x86_64)

Use the * and ¥ keys to select which entry is highlighted.
Press enter to boot the selected 0S, ’e’ to edit the
commands before booting, ’a’ to modify the kernel arguments
before booting, or 'c’ for a command-line.

Figure 3.4.4.1: Press space to select centos version mode

» Step 2:

GNU GRUB wversion 8.97 (636K lower ~ 3143552K upper memory)

root (hdB,8)

kernel Zumlinuz-2.6.32-358.e16.x86_64 ro root=UUID=915f1361-c4f3-4b8e~»>
initrd 7initramfs-2.6.32-358.e16.x86_64. ing

Use the t and 4 keys to select which entry is highlighted.
Press 'b’ to boot, 'e’ to edit the selected command in the
boot sequence, ’c’ for a command-line, ‘o’ to open a new line
after ('0’ for before) the selected line, 'd’ to remove the
selected line, or escape to go back to the main menu.

Figure 3.4.4.2: Select Kernel mode
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Telling INIT to go to single user mode.

init: rc main process (1229) killed by TERM signal
[root@localhost ~1# root

bash: root: command not found

[rootBlocalhost ~/1# passwd

Changing password for user root.

New password:

BAD PASSWORD: it does not contain enough DIFFERENT characters
BAD PASSWORD: is too simple

Retype new password:

passwd: all authentication tokens updated successfully.
[rootRlocalhost ~/1# _

Figure 3.4.4.3: Password Configuration

3.4.5 Static IP Routing Configuration with Linux:
For Static IP routing, at first configure IP Address, Network and Gate Way By

# vim ifcfg-eth0 and follow my image instruction. 291

» Step 1.

willson@localhost:/etc/sysconfig/network-scripts

file Edit View Search Terminal Help
[root@localhost ~]# cd /etc/sysconfig/network-scripts/
[root@localhost network-scriptsl# 1s

ifcfg-eth0 -isdn

ifcfg-lo

network-functions
network-functions-ipv6

[root@localhost network-scripts]# vim ifcfg-ethof

® willson@localhost:/etc/sysconfig/network-scripts
File Edit View Search Terminal Help

DEVICE=eth0

HWADDR=00:0C:29:D1:AC: 1F

TYPE=Ethernet
UUID=fdf57d75-46e8-491c-9328-798e5a91b6b4
ONBOOT=yes

NM CONTROLLED=yes

BOOTPROTO=static

IPADDR=192.168.50.35
NETMASK=255.255.255.0

GATWAY=192.168.50.1

Figure 3.4.5.1: IP Configuration Static
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» Step 2:
DNS server configuration by pressing # vim /etc/resolv.conf and assign DNS name

server

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Jerminal Help
[root@localhost ~]# cd /etc/sysconfig/network-scripts/
[root@localhost network-scripts]# 1ls

ifcfg-eth® ifdown-isdn ifup-aliases ifup-plusb init.ipv6-global
ifcfg-lo ifdown-post ifup-bnep ifup-post net.hotplug

ifdown ifdown-ppp ifup-eth ifup-ppp network-functions
ifdown-bnep ifdown-routes ifup-ippp ifup-routes network-functions-ipv6
ifdown-eth  ifdown-sit ifup-ipv6 ifup-sit

ifdown-ippp ifdown-tunnel ifup-isdn ifup-tunnel

ifdown-ipv6 ifup ifup-plip ifup-wireless

[root@localhost network-scripts]# vim ifcfg-etho

[root@localhost network-scripts]# vim ifcfg-etho

[root@localhost network-scripts]# vim /etc/sysconfig/network-scripts/ifcfg-etho
[root@localhost network-scripts]# vim /etc/resolv.confl}

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Terminal Help

# Generated by NetworkManager

No nameservers found; try putting DNS servers into your
ifcfg files in /etc/sysconfig/network-scripts like so:

DNS1=xXXX . XXX . XXX . XXX
DNS2=XXX . XXX . XXX . XXX
DOMAIN=1lab.foo.com bar.foo.co
nameserver 8.8.8.8

nameserver 8.8.4.4

#
#
#
#
#

ES

Figure 3.4.5.2: DNS Name server Configuration

» Step 3:

file Edit View Search Terminal Help

Starting NetworkManager daemon: [ 0K ]
[root@localhost network-scripts]# service NetworkManager restart
Stopping NetworkManager daemon: [ OK ]
Setting network parameters... [ OK 1]
Starting NetworkManager daemon: [ OK ]
[root@localhost network-scripts]# service NetworkManager restart
Stopping NetworkManager daemon: [ OK 1]
Setting network parameters... [ OK ]
Starting NetworkManager daemon: [ OK ]
[root@localhost network-scripts]# service NetworkManager stop
Stopping NetworkManager daemon: [ OK 1]

[root@localhost network-scripts]# chkconfig NetworkManager off

[root@localhost
[root@localhost
[root@localhost
[root@localhost

network-scripts]#
network-scripts]#
network-scripts]#
network-scripts]#

[root@localhost network-scripts]# service NetworkManager status
NetworkManager is stopped
[root@localhost network-scripts]# service network restart

Shutting down interface eth0: [ OK ]
Shutting down loopback interface: [ OK 1]
Bringing up loopback interface: [ 0K ]
Bringing up interface eth0: ~[ [ OK 1] .

Figure 3.4.5.3: Service Network Restart
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> Step 4.
When all configuration is complete then ping the IP # ping 192.168.50.1

willson@localhost:/etc/sysconfig/network-scripts

File Edit View Search Terminal Help

Bringing up loopback interface: [ OK 1]
Bringing up interface eth0: [ OK ]
[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# service network restart

Shutting down interface etho: [ 0K ]
Shutting down loopback interface: [ OK ]
Bringing up loopback interface: [ OK 1]
Bringing up interface ethO: [ OK ]

[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# vim /etc/resolv.conf
[root@localhost network-scripts]# ping 192.168.50.1

PING 192.168.50.1 (192.168.50.1) 56(84) bytes of data.

64 bytes from 192.168.50.1: icmp seq=1 ttl=64 time=19.2 ms
64 bytes from 192.168.50. icmp seq=2 ttl=64 time=1.62 ms
64 bytes from 192.168.50. icmp seq=3 ttl=64 time=0.978 ms
64 bytes from 192.168.50. icmp seq=4 ttl=64 time=1.79 ms
64 bytes from 192.168.50. icmp seq=5 ttl=64 time=2.91 ms
64 bytes from 192.168.50. icmp seq=6 ttl=64 time=2.98 ms
64 bytes from 192.168.50. icmp seq=7 ttl=64 time=2.25 ms
64 bytes from 192.168.50. icmp_seq=8 ttl=64 time=1.34 ms
64 bytes from 192.168.50. icmp seq=9 ttl=64 time=2.04 ms
64 bytes from 192.168.50. icmp seq=10 ttl=64 time=0.925 ms
64 bytes from 192.168.50. icmp seq=11 tt1=64 time=2.93 ms

e Iy Sy ST g

Figure 3.4.5.4: IP Ping of Static Routing
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CHAPTER 4

Conclusion and Future Career & Scope

4.1 Conclusion and Discussion:

In short of my internship project I will learn about configuring network by MikroTik
and Linux platform and how to make and configure network. | will also learn and
complete understanding about IP Classes. Main learning of this project was how to
configure ISP link, bandwidth Control in different ways, bridge mode configuration,
Firewall and NAT Configuration, Network Security, Linux installation, Run level of
Linux, Linux server administration. All of the instruction helps and improved me to
increase build my job aims and career skillful. That’s why now I can create ISP based
setup and administration on the Linux platform and provide entry-level work and
support. This project is completely hand course and provides information and aptitudes
which will introduce me to a Linux server for informative, informative and basic system
administration. Along with improving the most recent forms and server security, we
always see the reconstruction and role of the programming department. The MikroTik
and Linux operating system provide us a comprehensive introduction of steady, reliable
and successful administration. The Linux system provide us almost all system
administrators, Web server pioneer, SS, Telnet, DNS, FTP, mail server and so one.
Now, today most of the organizations are highly dependent on their work on the
network thought Internet. Therefor a proper network design is very important think of

an organization, without this it is not possible to manage all network support.

4.2 Future Career & Scope:
In real life finding a job can be a big challenge of anyone of our country, especially if
we have no experience. That’s why I choose internship, because it can help me to
improve my career opportunity into an experience. So, this internship provides me to
find scope in future life:

» Work in ISP based platform.

» Work at as an IT manager of a company.

» Work at as a Network Engineer.

» Work at as a technical support and security manager.
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Appendix: Company Information

Name

Address

Telephone

Fax

E-mail

Website

Type of Organization
Employees

Daffodil Online

Head Office

Daffodil Online Limited

102, Shukrabad (3rd floor), Mirpur Road, Dhanmondi,
Dhaka - 1207, Bangladesh

02-9143258-60

880-2-8116103

info(@daffodilnet.com

www.daffodilnet.com

Nationwide Internet Service Provider (ISP)
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